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Einfuhrung

Die Tanner EDA Tools von Siemens bilden ein Schaltkreisentwurfssystem fir digitale, analoge und
Mixed-Signal-Schaltkreise. Das System beinhaltet mehrere Softwarewerkzeuge flr das Zeichnen von
Schaltplanen, die Logik- und Timing-Simulation, den Layout-Entwurf und die Layout-Verifikation. Einen
Uberblick bietet die folgende kurze Beschreibung.

S-Edit (Schematic Editor — Grafische Eingabeoberflache zur Schaltplanerstellung):

S-Edit ist eine grafische Entwurfsoberflache fir die Eingabe von Schaltplanen und fiir deren Analyse.
Hier konnen eigene Module entworfen oder vorgefertigte Module aus Bibliotheken wiederverwendet
werden. Die mit dem Schaltplan erstellten Ausgabedaten kdnnen zur Simulation
(T-Spice), zum Layoutentwurf (L-Edit) und zur Verifikation (LVS) verwendet werden.

T-Spice (Circuit Simulator — Schaltungssimulator):

T-Spice ist ein Schaltungssimulator fir den IC-Entwurf. Als Eingangsdaten verwendet T-Spice Textda-
teien. Diese beinhalten neben den Netzlistendaten auch Simulationsbefehle. Diese Dateien kénnen mit
einem Texteditor erzeugt werden, lassen sich aus S-Edit exportieren oder mit L-Edit aus einem beste-
henden Layout extrahieren.

W-Edit (Waveform Viewer — Betrachter fiir Signalverlaufe):

Mit W-Edit konnen die in T-Spice simulierten Gréen visualisiert werden. Es sollte daher wahrend der
Simulation von T-Spice aufgerufen werden, um Simulationsergebnisse darzustellen.

L-Edit (Layout Editor — Grafische Eingabeoberflache zur Layouterstellung):

Fir die Schaltkreisproduktion notwendige Masken kdnnen mit dem grafischen Entwurfswerkzeug L-Edit
erstellt werden. Die Masken werden in Layern verwaltet. Die Maskendaten werden als GDS II- oder CIF-
Dateien ausgegeben.

L-Edit/SPR (Standard Cell Place & Route — Platzierung und Verdrahtung von Standardzellen):

L-Edit/SPR wird innerhalb von L-Edit verwendet, um aus einer schaltungsspezifischen Netzliste, einer
Technologiedatei und einer Standardzellenbibliothek ein Standardzellen-Layout zu generieren. Die
schaltungsspezifische Netzliste wurde zuvor von S-Edit erzeugt. Sie enthalt eine Beschreibung des De-
signs in Textform und die Verknipfungen mit den verwendeten Standardzellen.

L-Edit/DRC (Design Rule Check — Uberpriifung der Entwurfsregeln):

L-Edit/DRC ist ein Werkzeug, das die Einhaltung von technologischen Entwurfsregeln tberprift. Regel-
verstoRe konnen direkt im Layout dargestellt oder in einer Textdatei ausgegeben werden.

L-Edit/Extract (Extraktion einer Netzliste aus dem Layout):

Durch Extraktion kann aus einem fertigen Layout eine beschreibende Netzliste erzeugt werden. Diese
Netzliste liegt im Berkeley-PSpice-Format vor, das von T-Spice und zum LVS-Netzlistenvergleich (s. u.)
verwendet werden kann.

LVS (Layout vs. Schematic — Vergleich von Layout und Schaltplan):

LVS gestattet den Vergleich von Netzlisten. Dadurch kann festgestellt werden, ob ein Layout einem
Schaltplan entspricht. Die Eingabe bilden zwei Spice-Netzlisten, die aus S-Edit und L-Edit (mittels L-
Edit/Extract) exportiert werden.



Ubungsablauf

In dieser Ubung soll der standardzellenbasierte Entwurf digitaler Schaltkreise mit dem Entwurfssystem
»1anner EDA Tools* trainiert werden. Die folgenden Schritte sind daflir notwendig:

I. Eingabe des Schaltplans der gewilinschten Schaltung in S-Edit.

II.  Simulation der Schaltung im Schaltungssimulator T-Spice mit grafischer Ausgabe der Signalver-

laufe in W-Edit.

lll.  Export von TPR-Netzliste (fir die Layouterstellung) und SPICE-Netzliste (fir LVS) aus S-Edit.

IV. Layoutentwurf

1. Verwendung des Layout-Werkzeugs L-Edit.

2. Auswahl der Technologiedatei, der TPR-Netzliste und der zu verwendenden Standard-

zellenbibliothek.

Bestimmung der Eigenschaften des Padframes.

Automatischer Layoutentwurf mit L-Edit/SPR.

V. Verifikation: Prifung auf Einhaltung der technologischen Regeln mit L-Edit/DRC, Generierung
einer Netzliste aus dem Layout mit L-Edit/Extract, Vergleich der aus dem Layout und aus dem

Schaltplan erzeugten Netzlisten mit LVS.

VI. Export der GDS lI-Daten fir die IC-Herstellung aus L-Edit.
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. Eingabe des Schaltplans mit S-Edit

S-Edit unterscheidet zwei grundsatzliche Darstellungsarten:

e Schaltplan-Darstellung (Schematic Mode) zur Erzeugung eines Schaltplans.

e Symbol-Darstellung (Symbol Mode) zur Erstellung von Schaltplansymbolen.

Der Modus kann durch Klicken auf das jeweilige Symbol B in der Meniileiste umgestellt werden.

Schritt 1: Erstellen eines einfachen Moduls AD*DW

In diesem Schritt wird der nebenstehende Schaltplan mit

zwei Eingangen, einem Ausgang, zwei Invertern, zwei AND- Out

Gattern und einem OR-Gatter erzeugt. B

1. Start des Programms S-Edit und Anlegen eines neuen Designs:

2. Laden der Bauelementebibliothek:

Start von S-Edit, Erstellen des Designs mit File > New - New Design. Benennen des
Designs als ,XOR®. Es wird automatisch eine gleichnamige Bibliothek erstellt. Alle spater
selbst erstellten Module sollten in dieser Bibliothek angelegt werden.

In das Feld ,Create in Folder® wird der Pfad eingetragen, in dem das Design erstellt werden

soll (jetzt ,D:\Tanner\*, fir das eigentliche Pro- x|

jekt z. B. das ,Dokumente“-Verzeichnis)'.

Diesign: IXOR ;I | oK I
Erstellen eines neuen Schematic-Views mit cell: [xorz <o Keine Umlaute! J
Cell > New View. Die verschiedenen Felder i, gpe: [ochematc —

sind wie in der nebenstehenden Abbildung ge-
. . Interface name: I i (i
zeigt auszufiillen. < mgﬁzzgh

Hinweis: Die Namen des Designs und des Mo-  vewrame:  [man <= gaini
duls sollten unterschiedlich sein.

[~ Disable name validation

File:

|D:'l,Tanner'l,Lihraries'l,AII'l,AII.tanner j _ll
Auswahl der Bibliothek ,All.tanner*

aus dem Verzeichnis ,D:\Tanner\ ok | Cancel
Libraries\All“. Dadurch werden auto-
matisch alle notwendigen Bibliotheken hinzugeflgt?.

Ix

Laden der Bibliothek mit
File > Open > Add Library.

Libraries 1 X|

e Auswahl der Bibliothek ,LogicGates“ aus der Navigationsleiste |lzor [=
,Libraries"”. =

3. Auswahl und Platzierung von Instanzen: i andls P -

Auswahl des Gatters ,INV* und klicken auf Instance®. Es 6ffnet | =1
sich das Dialogfenster ,Instance Cell“. Hier kann z.B. ein
neuer Name eingeben werden.

Die VergréRerung des Schaltplans kann per Mausrad oder mit
den Tasten +/- angepasst werden. oo |v et |
Klicken auf die Position auf der Zeichenflache, an der das Gatter

erzeugt werden soll. Es werden zwei Inverter benétigt. Ein Klick
auf ,Done" schlielt das Dialogfenster. Smizeh  [alll] PEmefD

' Achtung: Das Verzeichnis ,D:\Tanner\“ nicht zum dauerhaften Speichern von Daten verwenden! Es kénnte durch einen an-
deren Benutzer oder nach einem Neustart geléscht werden! Daher Daten vor dem Ausloggen z. B. auf Z:\ kopieren.

2 Die Datei ,libraries.list* im Projektverzeichnis enthalt die Verweise auf alle geladenen Bibliotheken. Sollten Bibliotheken nicht
gefunden werden (,unresolved libraries®), sind die Pfade in dieser Datei zu andern.
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Wiederholung dieses Vorgangs fir die Gatter ,NAND2C*“ und ,NOR2C*.

Anordnen der Gatter wie oben abgebildet. Die Elemente lassen sich dazu mit der rechten
oder linken Maustaste auswahlen und durch Klicken und Halten der mittleren Maustaste
verschieben (auch mit Alt + linke Maustaste moglich)®.

4. Erstellen von Ports:

Erstellen von Eingangsports liber das Symbol = (Werkzeugleiste) und Klicken auf die Po-
sition auf der Zeichenflache, an der das Symbol erzeugt werden soll. Es 6ffnet sich das
Dialogfenster ,In Port Settings®, in dem als Name ,A" eingetragen und der Vorgang mit
,OK" bestatigt wird. Mit der Taste ,R* kann das Symbol danach rotiert werden.

Achtung:
Hame: .
B = ° keine Umlaute
¢ keine Leerzeichen
™ Disable name validation . keine einZeInen
otk Size (pE) Auto-repeat Kleinbuchstaben
8 P_ Ensbleautorel o keine reinen Zahlen
IV Confirrn bext of il
N ?b @ ET[E]-DO-EI I . e keine Zahlen am
. Justification—————————— Anfang
MFSFIFrT Orientation  |‘iest =

Wiederholen des Vorgangs fiir den Eingangsport ,B“.

Erstellen des Ausgangsports ,Out‘ nach Anwahl des Symbols ©| und Klicken auf die Zei-
chenflache an der gewiinschten Position. Gegebenenfalls Beenden der Port-Eingabe durch

Klick auf k|

5. Verbinden der Gatter mit den Ein- und Ausgangsports:

x|
Jede Schgltung kann durch ein Symbol_ reprasentiert wer- o, [ror | o |
den, um die Schaltung in einer héheren Hierarchieebene ver- - o = ‘
wenden zu kénnen. - _ ol |
Wiew type: Isymbal LI
1. Erstellen eines neuen Symbol-Views mit Iterface rame: [ main |
Cell > New View. Die verschiedenen Felder sind " [rar
. . . . 2wy name
wie in der nebenstehenden Abbildung auszufil-
len. [~ Disable name validation

Auswahl des Verdrahtungssymbols B in der Schaltplan-Werkzeugleiste.

Die Verdrahtung wird mit der linken Maustaste ADA-DQH
gestartet und mit der rechten Maustaste beendet.

Verdrahten der Schaltung wie abgebildet. Der
Verdrahtungsmodus wird mit einem Klick auf das Out

Symbol & oder lber die Taste ,ESC" beendet. B

Alternativ kbnnen zwei grafisch unverbundene Teilnetze auch elektrisch verbunden werden,
indem sie die gleiche Bezeichnung (Net Label, Symbol: #¥) zugewiesen bekommen.

Test: Verdrahtung des Netzes zwischen einem NAND2C und NOR2C per Net Label.

Schritt 2: Erstellen eines Symbols fiir die eingegebene Schaltung

3 Mit den Tasten + und — oder mit dem Mausrad kann die Ansicht vergroRert bzw. verkleinert werden. Besonders praktisch ist die
Taste Pos1 / Home, da hier die Bildgrofie automatisch angepasst wird. Mit den Pfeiltasten ist die Bewegung innerhalb des Arbeits-
bereichs méglich.



2. Zeichnen eines Rechtecks nach Klick auf das Symbol [J.

3. Erstellen der Ein- und Ausgangsports (,A*, ,B", ,Out®) wie
zuvor beschrieben (Symbole ©| und IZ>|). Dabei muss be-

achtet werden, dass die gleichen Namen wie im Schaltplan
(siehe Schritt 1.4) verwendet werden. AlD—
4. Nach Auswahl des Symbols . koénnen die Beschriftungen B

des Moduls (A, B, Out) hinzugefligt werden.

% (O

A
Out

B XxOR2

— > Out

5. Mit dem Pfad-Werkzeug (1 ) kann das Rechteck mit den Ports verbunden werden. Die linke
Maustaste beginnt das Zeichnen von Linien, die rechte beendet es.

Schritt 3: Erstellen des Top-Level-Moduls

Das Top-Level-Modul besteht aus:

e Einer Instanz des zuvor erstellten Moduls ,XOR2".

e Zwei Eingangspads mit je einem Eingangsport.

e Einem Ausgangspad mit einem Ausgangsport.

e Einem Massepad mit einem bidirektionalen Port.

e Einem Betriebsspannungspad mit einem bidirektionalen Port.

Pad RZ2 Gnd

PadIn

Pad_L1_A[ >

Pad_LZ_B[ >

©

PadIn 1

.

<

Padend

&

Padvdd

Padend_1

Padvdd_1

pad_L3_vdd

PadIn

©

PadIn 2

]

cut

HORZ

[ G

PadOut
Padout_1

Die Pads sind Anschlussflachen flir die Au3enanschlisse des Schaltkreises.

Erstellen des Top-Level-Moduls:

1. Generieren eines neuen Top-Level-Moduls:

e Erstellen eines neuen Schematic-Views mit
Cell > New View. Die verschiedenen Felder
sind wie in der nebenstehenden Abbildung aus-
zufillen.

2. Erzeugen einer Instanz des ,XOR2"“-Moduls:

rewview x]
Design: I AOR j oK I
el | TopLevel j Cancel
Wigw Evpe! Ischematic j
Interface name: I main j
Wiy name: I main
r Disable name walidation

>Pad_R1 out

e Auswahl der Bibliothek ,XOR" aus der Navigationsleiste ,Libraries”. Auswahl des Moduls
,XOR2“ und klicken auf den Button ,Instance“. Dadurch 6ffnet sich das Dialogfenster

.nstance Cell".

o Kilicken auf die Position auf der Zeichenflache, an der die Gatter erzeugt werden sollen
(gegebenenfalls zoomen). AnschlieBend das Dialogfenster ,Instance Cell* mit ,Done”
schliel®en.



3. Platzieren von zwei Eingangs- und einem Ausgangspad (,PadIn“ bzw. ,PadOut‘) aus der
Bibliothek ,]O_Pads*.

4. Platzieren je einer ,,PadGnd“- und ,,PadVdd“-Instanz. Diese befinden sich ebenfalls in der
Bibliothek ,10_Pads*“. Erstellen von zwei Eingangsports, zwei bidirektionalen Ports und des
Ausgangsports wie zuvor beschrieben. Benennung der Eingangsports als ,Pad_L1_A*“ bzw.
LPad_L2_ B der bidirektionalen Ports als ,Pad_L3_Vdd* bzw. ,Pad_R2_Gnd" und des Aus-
gangsports als ,Pad_R1_Out".

Hinweis: Mit der Bezeichnung der Ports 1asst sich die gewinschte Lage eines Pads in dem zu
erzeugenden Layout angeben. Die Nummerierung erfolgt dabei entgegen dem Uhrzeigersinn,
wobei sich ,Pad_L1_A*links oben und ,Pad_R1_Out*rechts unten im Padframe befinden (siehe
auch die Dokumentation der Tanner Tools). Die Pads zur Spannungsversorgung (Vdd, Gnd)
mussen immer an gegenlberliegenden Seiten des Schaltkreises angeordnet werden, damit die
Standardzellen von beiden Seiten erreicht werden kénnen. Empfehlenswert ist ihre Anordnung
auf der linken und rechten Seite, da andernfalls der Schaltkreis aufgrund zusatzlich notwendiger
Power-Rails héher wird.

5. AbschlieRend werden alle Elemente mit dem Verdrahtungs-Werkzeug ( E’) verbunden.

Pad RZ Gnd o G} Pad L3 vdd
Padend Padvdd
PadIn
Padend_1 Padvdd_1
Pad L1 B[ » )
PadIn 1 A
= out D— e} »Pad R1 out
Eadln B Padout
KORZ Padout 1
Pad L2 B[ > )
PadIn 2 —

6. Abspeichern des Designs (File > Save - Save Design XOR).

Hinweis: Durch einen Doppelklick auf ein Symbol, z. B. das des XOR2-Moduls, wird - _{3 .
der zugehdrige Schaltplan gedffnet. Alternativ kann nach der Auswahl eines Moduls -

per Klick auf das Symbol & die nachste Hierarchie-Ebene angezeigt werden. Die

nachsthéhere Ebene bis hin zum Toplevel-Modul wird durch Doppelklick auf einen

leeren Bereich der Zeichenflache erreicht (Alternative: Klicken auf das Symbol & ).

Jetzt kann aus dem Design eine Netzliste erzeugt werden. Diese dient spater als Grundlage fir die
Platzierung und die Verdrahtung in L-Edit. Vorher ist es jedoch sinnvoll, das Design durch Simulation
zu Uberprufen. Mit diesem Schritt befasst sich der nachste Abschnitt.



Il. Simulation

Durch Logiksimulation kann bereits vor dem Erstellen des Layouts die logische Funktion simuliert und
Uberprift (verifiziert) werden. Dazu kommt im Hintergrund das Programm T-Spice zum Einsatz.

Die hier behandelte Beispielschaltung wird durch die Logiktabelle links im Bild beschrieben. Zur Verifi-
kation wird (soweit mdglich) fur jeden Eingangszustand ein Testvektor (z. B. ) an die Eingange ,A"
und ,B“ angelegt und gepriift, ob sich der Ausgang ,Out* wie gewiinscht verhélt (im Beispiel ).

Print Voltage Padln 1.

Pad L1 A[ > & —

PadIn_1 — Print Voltage

+
s L.,
- ont D—E} [ >Pad R1 out

Voltagesourcd 1

—— B Padout
XORZ Padout_1

[ Print Voltage Padln | .

Pad_L2 B[_>» © — P

PadIn_2 —

_\_\OO>

e (=l ey [=2] )

Out
0
1
1
0

VoltageSource 2

2
il
Zur Simulation werden zusatzliche Elemente im Schaltplan bendtigt.

e Alle Signale, die mit einer Instanz des Moduls ,,Print Voltage® verbunden sind, werden spater in W-
Edit angezeigt. In dieser Ubung kommen die Eingangs- und Ausgangssignale ,Pad_L1_A*
.Lad_L2_B*und ,Pad_R1_Out"in Frage.

e Es werden Spannungsquellen zur Erzeugung der Zustande fur die Testvektoren bendtigt. Daflr gibt
es unterschiedliche Methoden, z.B. die Verwendung von Rechteckquellen mit unterschiedlicher
Pulsweite und Frequenz. Zu Beginn sind alle Signale logisch 0, so dass an beiden Eingangen eine
0 anliegt. Als nachstes wird die Rechteckquelle mit der kiirzesten Periodendauer logisch 1 (in die-
sem Fall ,VoltageSource_1“), so dass der Testvektor 01 anliegt, usw. Eine weitere Mdglichkeit ist
die Benutzung einer bindaren Spannungsquelle (Bit) mit passenden Bitmustern.

e Zusatzschaltungen kdnnen die spatere Signalauswertung vereinfachen. Zum Beispiel ist es mog-
lich, Zahlerausgange per Widerstandsleiter (DA-Wandler) als ein einzelnes Signal auszugegeben.

¢ Die notwendige Betriebsspannung wird durch die Spannungsquelle ,Vdd“ bereitgestellt.

Schritt 1: Einrichten der Simulation

Die Simulation einzelner Module erfolgt durch Erzeugen eines =
neuen Schematic-Views namens Modulname_Testbench. Darin ... o]
werden eine Instanz des Moduls, erforderliche Pad-Zellen und die  pesent o= e

ubrigen Elemente einer Testbench erzeugt. Der Einfachheit halber Gollname:  [Toplovel =]
wird hier die XOR2-Testbench auf Basis des eben erstellten Moduls .«
.TopLevel“ erstellt. eeeny R =
Cell name: W

~Copy dependencies
1+ None
"~ Needed only
ol

1. Auswahl des Moduls ,TopLevel“ aus dem Design ,XOR".

2. Erzeugen einer Kopie des Moduls ,TopLevel* mit Cell >
Copy Cell. Der neue Name ist , XOR2_Testbench®.

V¥ Ovenarite existing cell

I™ Disable name validation Preview. ..

3. Das Modul ,XOR2_Testbench* wird nach dem Kopieren
automatisch geoffnet.

4. Entfernen der beiden Padzellen ,PadGnd_1* und ,PadVdd_1“ und der zugehérigen Ports.



5. Auswahl und Platzieren der zwei Rechteckquellen ,VoltageSource_1“ und ,Voltage-
Source_2“ aus der Bibliothek ,SPICE_Elements®. Dazu soll im Feld ,Interface“ die Option
.Pulse” ausgewahlt werden. Die ,Properties” sind wie folgt auszuftllen:

10.

Instance Cell Instance Cell

Instance name: | wolkageSource_L Instance name: | YoltageSource_2

[™ Disahle name validation [™ Disable name validation

r—Instance of r—Instance of
Design: ISPICE_EIements j Design: ISPICE_EIements j
Cell name: I\-'oltageSource j Cell name: IVoItageSource j
Interface: Pulse h Interface: IPuIse j
Symbaol view: IPuIse j Symbol wiew: IPuIse j

Properties: Propetties:
MName | Yalue MName |
Delay Delay
FallTime ns FallTime
Period 200ns Period
Pulsetidth 95ns Pulsetidth
RiseTirne Sns RiseTirne
ROUMND a ROUMND
WHigh S WHigh
WLow O Yiow

Done | Cuore: |
4 4
. ‘ .
Auswahl und Platzieren der Quelle ,Vdd“. Dazu wird I

-SPICE_Elements* > ,Voltage Source” gewahlt. Im Feld
.Interface“ soll die Option ,DC*“ ausgewahlt werden.

Auswahl des Massesymbols ,Gnd“ und des Betriebsspan-
nungssymbols ,Vdd“ aus der Bibliothek ,Misc* und platzie-
ren gemaf der Abbildung oben.

Auswahl und Platzieren der drei ,Print Voltage“-Instanzen
aus der Bibliothek ,SPICE_Commands®. Verbinden der
Symbole mit den Eingangs- und Ausgangssignalen.

Auswahl des Symbols B’ und Verbinden aller Symbole ge-
malR der Abbildung oben.

Instance name: -

[ Disable name validation

r Instance of

Design:

|5PICE _Elements

Cell name:

IVDItageSource

Interface: . - l

=

Swmbol view: IDC j
Properties:

Mame | Walue

W 5.0v

Die Festlegung der Simulationsparameter erfolgt mit ,Setup = SPICE Simulation®. Es &ffnet

sich ein Dialogfenster.

e Option ,General“ auswahlen und die verschiedenen Felder wie in der folgenden Abbildung ge-

zeigt ausfillen.

EN Setup SPICE Simulation of cell "XOR2_Testbench®

X

Bl General
Reference Temperature (deg. C)
Accuracy and Performance

B Simulation Outputs
Show Waveforms

7 4 Options
Hierarchy Priority
Additional SPICE Commands
Parameters
PICE Cptions
i Operating Point Analysis
ransient/Fourier Analysis
CTDC Sweep Analysis
[ AC Analysis
] Moise Analysis

Enable Waveform Yoltage Probing
Enable Wwaveform Current Probing
Enable Waveform Charge Probing

[l File and Directory Names
SPICE File Mame

Default

Curing

False
False

1 Transfer Function Analysis
[] Temperature Sweep

[ ] Parameter Sweep

[ Cornet Simulations

File Search Path
Include Files

Libraty Files

Werilog-A Search Path

[/ Tanner/LibrariesModels

“Gemetic_025. k" TT <:

Exakt so libernehmen!
Mit Anflihrungszeichen und
Leerzeichen vor , TT*.




e Option ,Transient/Fourier Analysis“ auswahlen und die verschiedenen Felder wie in der fol-

genden Abbildung ausfullen.

[N Setup SPICE Simulation of cell 'X0R2_Testbench’

X

General

Metlisting Options

Hierarchy Priority

Additional SPICE Commands
Parameters

SPICE Options

DiZ Operating Point Analysis
ransienkiFourier Analysis
[ D Sweep Analysis

Stop Time
Maximum Time Step

,us®, nicht ,us”!
100ps

Print Time Step
Use Initial Conditions
Startup Mode

False
Op

E Fourier Analysis
Enahle Fourier analysis

False

11. Abspeichern des Designs (,Save Design XOR").

Schritt 2: Durchfihrung der Simulation

Starten des Simulators T-Spice durch Klick auf das Symbol » in S-Edit.

Es o6ffnet sich W-Edit zur Darstellung der Eingangs- und Ausgangswellenformen. Der Menu-

punkt Chart > Expand Traces weist jedem Signal ein eigenes Diagramm zu. Nun kann das
Ausgangssignal Uberprift und mit dem gewilinschten Resultat verglichen werden.

1.
2.
2 EE 0 o -
e B EN N
T x D XO0RZ:schemal
T
Hinweise:

W W-Edit - [Chart1 (Transient)]

Fle Edt Wiew Draw Chart Setup Window Help

1o x|

-8 X

DRFEd|xr=eloc|se ele | || seect [ move

| smect

RlepbmnxAVesd 2lér @3 il 8

1.0040u : 1.45

[} chart1 (Transient) |

d4bx

[Tanner T-Spice 15.16

10:24:01 02/28/12

o 10000 20000 on 400.00 500.0n on 70000 on
Seconds

<00

on

1,000

[Selection: <none= |Select

[cap [Num [ovr 4

e Durch Auswahl des ,Probe-Voltage“-Symbols ("\) in S-Edit kann jedes Signal durch Klick
auf das zugehdrige Netz angezeigt werden, z. B. zur Fehlersuche.

e Diagramme kénnen per Rechtsklick und Auswahl von ,Move Plot* neu angeordnet werden.
e Ausdruck im Querformat ist nicht moglich.
e Das Speichern von Simulationsergebnissen, so dass sie spater wieder in W-Edit geoffnet
werden konnen, ist mit folgender Vorgehensweise moglich:
(1) In den Simulationseinstellungen in S-Edit unter ,General®, ,Simulation Results
Folder” einen Ausgabepfad speziell fur das aktuelle Modul festlegen.

(2) Unter diesem Pfad wird automatisch ein Verzeichnis <Name des Moduls>, sowie

eine Datei <Name des Moduls>.tsim erzeugt.

(3) Simulationsergebnisse in diesem Verzeichnis werden bei jeder Simulation ber-
schrieben, es sei denn, in den Simulationseinstellungen wird die Option ,Keep all

simulation results” auf True gesetzt.

(4) Das Chartbook von W-Edit sollte ebenfalls in diesem Pfad neben der tsim-Datei

gespeichert werden.

3. Schlieen von W-Edit und T-Spice.

4. Abspeichern des Designs (,Save Design XOR").
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lll. Exportieren der Netzlisten

Aus dem simulierten Schaltplan wird eine Netzliste im TPR-Format (Tanner Place and Route) erzeugt.
Diese wird vom Layoutwerkzeug L-Edit/SPR (Standard Cell Place and Route) verwendet, um das Lay-

out zu erzeugen.

Aus dem Schaltplan wird weiterhin eine Netzliste im SPICE-Format erstellt, die fur den nachfolgenden
Verifikationsschritt (LVS) bendtigt wird.

Vorgehensweise:
1.
2.

3.

—To file

Ii D4 Tanmer K ORNTopLevel. for I - l oo |

—Export source

Design: I ¥OR
cell: I TopLevel
“ig I schematic

—Export contral property

Property name: I TFR

—Options

[ Export toplevel ports as pads

Auswahl des Designs ,XOR* aus der Navigationsleiste ,Libraries”.
Offnen des Moduls ,TopLevel“ (nicht der Testbench) durch Doppelklick.

Exportieren der TPR-Netzliste mit File > Export - Export TPR

x|
e |
Cancel |

In dem neuen Dialog wird als Dateiname ,TopLevel.tpr‘ eingetragen. Ein Klick auf ,Export®
schliel3t das Fenster.

Export TPR

5. Die SPICE-Netzliste wird Uber File > Export > Export SPICE erzeugt. Eine eventuell vorhan-

dene alte Datei kann (iberschrieben werden.

Export SPICE

General | Hierarchy Priority |

—Tofile

IiD:\Tanner’\XOR\TopLevel.spci

[~ Confirm ovenwrite

=

—Export source

Design: |><OR
Cell: |TDpLeveI
e |schematic

6. Schlie’en von S-Edit.

L L

xJ
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IV. Layoutentwurf

Nun wird L-Edit/SPR (Standard Cell Place and Route) verwendet, um das Layout des Designs zu ge-
nerieren. Die Layouterstellung beinhaltet das Platzieren (Placement) und Verdrahten (Routing) der
Standardzellen und Aufienanschlisse (Pads).

1.

Kopieren aller Bibliotheksdateien aus dem Verzeichnis ,D:\Tanner\Libraries\Tech Files\ in
das aktuelle Design-Verzeichnis (z. B. ,D:\Tanner\XXOR\").

Start des Programms L-Edit.

Auswahl der Technologiedatei, der Netzliste und der Standardzellenbibliothek:

Replace Setup Information
From file: oK
’hD:\Tannel‘\XOR\Tech_lm‘o.tdb] Browse... |

Cancel

Zuerst werden die Technologie-
Informationen durch Auswahl von
File > Replace Setup importiert.

Im Dialogfenster wird nach Klick auf
.Browse" die Datei ,Tech_Info.tdb" rLayers |
im aktuellen Verzeichnis lokalisiert. IV Layers

e

Uncheck All

Verlassen des Fensters mit ,OK®. Die ausgegebene Meldung nochmals mit ,OK® bestatigen.

Durch Auswahl von Tools > SPR > Setup wird das Dialogfenster ,SPR Setup” gedffnet. Hier
wird als Standardzellenbibliothek ,morbn20d.tdb“ und als Netzliste ,TopLevel.tpr* eingetra-
gen.

Mit ,Initialize Setup“ werden jetzt die Standardzellenbibliothek und die Netzliste geladen.

x|
eni Tock Window Help
7 Generats Lavers., e nE =& I - Standard cell library file
oK

g+ e A e EEY Browse Lo |
U o B 6 el A e |
M DRCBox e a®ig s Netlitfile
T DRCSetp.. -

Check Geormetry Flags. . ’7 D\ Tanner=<OR\TopLevel tpr Browse

Clear Error Layer.

et Teracie DRE s Fead netlist show mapping tatle: apping Takle..

geDrl\_ﬁ;aUOH ErrorNawgator r Read neflist, inifialize setup dialogs Inttialize Setup l

lavigator L4 S
SPR. Y Setup.., Femowve power and ground nets from the nethslan_d
p— e [ O e ot e s e o s g g
- Power/Ground node and portnares——————————————————————
Paower signal |\/dd Core Setup..
Ground signal: |Gnd
! Padframe Setup.. l
Pad Route Setup..

4. Bestimmung der Eigenschaften des Padframes®. x|
Auswahl von ,Padframe Setup®, um den Dialog [ Fedfeme dimencions Larbd Reset |
,SPR Padframe Setup“ zu 6ffnen. (”:":‘“'HD” — G

nter "0" for automatic acjustmen
In der Registerkarte ,Layout” konnen die Abmes- | pesiet
. . # Instance name Side Mirrar Power/Ground
sungen des Padframes bestimmt und die Lage Pacin T —
. 2 Padn_? Left Mo
der Pads gepriift werden. 3 Pedvadl Lt N0 Ve
4 PadQut_1 Right No
. . « . . 5 PadGndl Right Mo Gnd
Unter ,Padframe dimensions“ wird die ge- *
winschte Breite (,Width“) und die Hoéhe
(,Height") des Padframes eingegeben. Wird hier
jeweils 0 angegeben, werden Breite und Héhe Orser padk countercinskaise, upper e - botom - ight-1op
automatisch festgelegt. i pee |
Abbrechen

4 Der Padframe ist der duRere Rahmen, auf dem sich alle AuBenanschlisse (Pads) befinden. Er stellt die Verbindung zur ,&u-
Reren Welt" dar — z. B. zur Leiterplatte (bei Nacktchip-Verarbeitung) oder zu den Schaltkreis-Anschlussbeinen (bei gehdustem

Chip).
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Die ,Padlist“ gibt die Lage der Pads an. Die Nummerierung (Spalte ,#“) erfolgt dabei gegen
den Uhrzeigersinn, wobei sich Pad 1 links oben im Padframe befindet.

Durch zweimaliges Klicken auf ,OK* werden eventuelle Anderungen ibernommen.

5. Automatischer Layoutentwurf in L-Edit/SPR:

Nach Auswahl von Tools > SPR > Place and Route 6ffnet sich der Dialog ,Standard Cell
Place and Route“. Um das komplette Layout zu generieren, werden alle drei Module (,Core
place and route®, ,Padframe generation“ und ,Pad route®) ausgewahlt (siehe Abbildung). In
dieser Einfliihrung wird die Optimierung der Platzierung nicht verwendet. Spater sollten unbe-
dingt sowohl die Optimierung der Platzierung als auch die Verdrahtungsoptimierung aktiviert
werden. Der Optimierungsfaktor ist dann geeignet im Bereich von 0 bis 10 zu wahlen. Die Ver-
anderung der Randbedingung (,Constraint®) kann das Layout weiter verkleinern. Weitere In-
formationen zur Layout-Optimierung sind Uber Help - Placement and Routing verfiigbar.

[v Core place and raute

[ Global input signal routing

Core configuration

Canstraint
Fow ength (Lamkbda)

Murntaer af ravwe

standard Cell Place and Route il
Run
Accept |
ISquare LI
0000 Cancel
0
Fficloll e/t ratio: 1.0 S |

[ Indent middle raws

5

s | SieheTextt [

Netlength and Via Reduction v |

Output optian:

[~ Label nodes with parts

[ white CAP file IC\ArbEiI‘\REE\Zm 2 Tannet=0R Top Browse

l_ Wite SDF file IC\Arhelf\REE\ZmZ\Tannel‘\XOR\Tnp Browse

v Padframe generation

[ Pad route

Der Abschluss von Platzierung und Verdrahtung wird mit einer Meldung quittiert. Nach der Be-
statigung durch ,OK* wird das generierte Layout dargestellt®:

Pad 1 (A)

Pad 3 (Vdd)

,,,,,,,,,,,,, Kern (Core), be-
stehend aus funf
Standardzellen

Pad 5 (Gnd)

I

Vdd-Anschluss der
Standardzellen

Signalverdrahtung
(Kanalverdrahtung)

Gnd-Anschluss der
Standardzellen

5 Mit den Tasten + und - kann die Ansicht vergroRert bzw. verkleinert werden (auch mit dem Mausrad mdglich). Am praktischsten ist
die Taste Pos 1, da hier die BildgroRe automatisch angepasst wird. Mit den Pfeiltasten ist die Bewegung innerhalb des Arbeitsbe-

reichs moglich.
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V. Verifikation des Layouts

Die Layoutpriifung (Verifikation) beinhaltet zwei Schritte:

e Prifung auf Einhaltung der Technologieregeln: DRC (Design Rule Check)

e Prifung auf Ubereinstimmung mit dem Schaltplan durch Netzlistenvergleich: LVS (Layout versus
Schematic).

Wahrend der DRC direkt im Layout durchgefiihrt wird, erfordert der LVS aus dem Schaltplan
(S-Edit) und dem Layout (L-Edit) erzeugte SPICE-Netzlisten. Zur Netzlisten-Erzeugung aus dem Layout
dient die Extraktion mit L-Edit/Extract. Die dabei zu erkennenden Schaltungselemente sind in ihrer Be-
schreibung (z. B. als konkrete Ebeneniiberlappungen) in einer Extraktionsdatei (extract definition file)
festgelegt.

Schritt 1: Priifung auf Einhaltung der technologischen Regeln (DRC)

L-Edit/DRC ist ein Werkzeug, das ein Design auf das Einhalten von Entwurfsregeln (z. B. Uber-
lappungen, minimale Breite und minimaler Abstand) hin Uberprift. Durch Auswahl von
Tools > DRC wird die Verifikation gestartet. Nach Abschluss der Verifikation zeigt ein Dialog-
fenster, ob das Layout die Regeln einhalt.

Werification Error Navigator X
g s 3| &lEleE|+|X
[Derars IChip e
_ g Mo errors to display.
selp | Tools Window  Help O Fun DRC or Extract to find rule violations and display thern here.

Fd p GenerateLayers...
Clear Generated Layers...

efault

DR

‘ | Stat DR

L

Schritt 2: Netzlistenvergleich (LVS)
1. Generierung einer SPICE-Netzliste aus dem Layout mittels L-Edit/Extract:

e Zur Konfiguration der Layout-Extraktion, wird Tools - Extract Setup ausgewahlt. Es
offnet sich das Dialogfenster ,Setup Extract®.

Setup Extract il Setup Extract il
General |Dp|mns:| Geners
Exdract Rule Sets to run [~ Statements to include before netlist
[ O A 2 =]
morbn20.ext
~ Output option
[V \Write empty subcircuit definitions
¥ Writs .model statements
Calibre defines: |
[~ Save node-highlighting data: To folder
[ SPICEexroctounuttie | Pfad per Tastatur Device label
ID\Tanner‘\xOR\TD Level_Layout.s EIZ :f i 1 Di i
a vou e emgeben- Die Datei [~ Place ports as device labels
existiert noch nicht.
- Tolayer | =
[~ Owerwite existing outputfile
[~ Open SPICE outputfile after extracting ‘  "HiPereriy" oplio
—When extract compl [ Wiite hierarchical netlist [ Wiita node name aliases
[~ Send email to: Configure. [™ Runinbackground
Loek participating cells while extract runs,
[~ Flay sound Configure n pERR
[~ Pop up message box [~ Only far wamings: Exiract as:
’7(-‘ Toplevel cell " Subcircuit ‘
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e Im Feld ,Extract Rule Sets to run“ (Liste der Extraktionsdateien) wird die Datei
~-morbn20.ext* im aktuellen Design-Verzeichnis angegeben.

e Im Feld ,SPICE extract output file® (zu erzeugende SPICE-Netzliste) wird
.TopLevel_Layout.spc” eingetragen.

e Auf dem zweiten Reiter ,Options” dirfen in der Gruppe ,HiPer Verify options® keine
Felder ausgewahlt werden.

Die Auswahl von Tools = Extract startet die Extraktion. Dabei auftretende Warnungen tber
unattached ports und short circuits kdnnen ignoriert werden. Im Ergebnis liegt eine Netzliste im
SPICE-Format vor, welche das Layout in Form von Bauelementen und Verbindungen be-
schreibt.

Abspeichern des Layouts als ,XOR_Layout.tdb“ und Schlieen von L-Edit.
Start des Programms LVS.

Nach Auswahl des Symbols 8 bzw. File > New 6ffnet sich der Dialog ,New File“. Dort wird
,LVS Setup“ ausgewahlt und durch ,,OK* bestatigt.

Es folgt die Definition der zu vergleichenden Netzlisten. Uber ,Browse* werden die aus dem
Layout extrahierte Netzliste ,TopLevel_Layout.spc” und die Netzliste des Schaltplans ,TopLe-
vel.spc® ausgewahlt.

B setup1 _ =] x|
Input | Output | Device Parameters | Merge Devices| Pavasmcsl Options | Perfurmance|
ELavout Versus Schemati | il .
Fle Wiew Setup  Verificaion  Window  Help
Layout neflist T-Spice + || [D:\TannenxORy TopLevel_Layoutspc Browse Edit
| = f Browee. |_eot |
Schematicnetlist [T-Spice - lD\Tannef\xoR\TupLeve\spc I Eirowse Edit
File type
- |
SPICE Natlist Optional input fil
Text
Log File [~ Prematch file: I Erowse.. | Edit
[~ Element description file: | Browse Edit
Ready Line 107 /:

Auf dem Reiter ,Merge Devices*“ muss der Eintrag in der Zeile ,Mp*“ auf ,All“ gesetzt werden.
Das bewirkt eine automatische Zusammenfassung paralleler Transistoren, so dass diese zu
keiner Meldung Uber Unterschiede zwischen den Netzlisten fihren. Weiterhin muss der Punkt
.Remove shorted devices“ ausgewahlt werden.

=15/

Input | Output | Device Parameters urasilics| Options. | Perluvmsncel
~Merge series and parallel R. L C; parallel B, D, J. Q, Z: parallel M, and stacked M which share gates
R:  [None =1 setll |
153 |None LI |
GE INone LI | ml
5 [Nome =
D: INone ll |
e |Nnne ~| |
Q: |None ll |
3 -
Mp: |Al -
‘Ms: |None 2
—Series MOSFET optimization (treat series MOSFETS as logically equivals
Series MOSFETs  |None =
™| Find series MOSFETs thet differin order.or parameter values

emove device

Remove shorted devices [~ Remove disconnected devices
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7. Nun kann der Netzlistenvergleich (=[]

deCh K||Ck an daS Symb0| .‘ Layout netlist D TannefOR\Toplevel_Layoutspc Parsed and Flattened
bZW. Auswahl Von verification 9 :}::‘:t::il:;etlis\ {J\Tanner‘\xOR\Taneve\spc Parsed and Flattened
Run gestartet werden. EIRp—
Outputfile:
) 3 . ) Mode and element list
8. Als Ergebnis wird angezeigt, ob die

Cunrent process

beiden Netzlisten dieselbe Schal- L L L]
tUng beSChrelben Oder ob Sle Un- | Result:  Circuits are equal Note: Devices have been merged.
terschiede aufweisen. e —

NENEEENEEEEEENANNEENEEEEENEEENEENEEENENNENNNNNNNENNENNENNNENNENRREEE]
85% done B

9. Schlief’en von LVS. s Sonei
1EIU;; done:

FINAL RESULT

Mote: Devices have been merged.
Circults are equal.
Run time: 0:01 (min:sec)

VI. Export der GDS lI-Daten aus L-Edit

Abschlieftend kénnen die GDS Il-Daten aus L-Edit fur die IC-Herstellung exportiert werden. Folgende
Schritte sind dazu notwendig.

1. Start des Programms L-Edit und Offnen des Designs ,XOR_Layout.tdb*.

2. Nach Auswahl von File > Export Mask Data - GDSII 6ffnet sich ein Dialogfenster. Dort wird
im Feld ,To file* der Dateiname ,XOR_Layout.gds"“ eingetragen. Ein Klick auf ,Export* er-
zeugt die GDS lI-Datei.

Export GDSII x|

— Taofile:

e ___| Dateinamen per Tastatur e
eingeben! Die Datei existiert Pslldefault(1 database unit = 0.001 microns)

I Zip outputile eventuell noch nicht. stom: 1 database unt=  [0.001 micrang

T
. 1 database unit= |0.001 usEer units
—Log file:

[~ Save log fils ta:
— Cell narmes:
I Elfe e ® Preserve case (" Upper case i Lower case
[¥ Open log inwindow Restrict cell names to: |32 (Standard) w | characters
[ Do notexpatt hidden objects and layers - Exportcall
[ Overwrite ohject data type with layer data type @ Allcells
[™ Caloulate MOSIS checksum  Selected cell and its hierarchy
[~ Check for self-intersecting polygons and wires -
Cell: [Chip .
[~ ‘hhite XrefCells as links
Fracture:

[~ Fracture polygons with more than

15 vertices

[ ] oo |

3. Schlie3en von L-Edit

Literatur

Onlinedokumentation der Tanner Tools
(unter Start = Programme - Tanner EDA - ... > Documentation verfiigbar)
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Glossar

ASIC

Contact

Core

DAC / DA-Wandler
Gate / Gatter
GDS I

Gnd / GND

Instance / Instanz

Layer
Layout

LVS

Mixed-signal (circuits)

Modul

NAND-Gatter
Netzliste
NOR-Gatter

Pad
Padframe
Pad routing
Port

Power rail
SPICE
Standardzellen

Top-Level(-Modul)
TPR (Format)

Via
\VVdd / VDD
XOR-Gatter

Application-Specific Integrated Circuit — anwendungs-
spezifischer integrierter Schaltkreis — fUr eine spezielle
Anwendung entworfener Schaltkreis

Durchkontaktierung zum Verdrahtungsanschluss einer Zelle

Bereich einer Schaltung, in dem (Standard-)Zellen und ihre
Verdrahtung angeordnet sind (ohne Pads / Padanschlisse)

Digital-Analog-Wandler
Zelle zur Realisierung einer logischen Funktion (z. B. NAND)

Binares Dateiformat fiir Layout-Informationen — wird an den
Schaltkreishersteller Gibergeben

Ground, Masseanschluss

Virtuelle Modulkopie durch Referenz auf ein Originalmodul
(Ableitung eines Bibliotheksmoduls zur Nutzung in Schaltung)

Darstellungsebene

Topologische Darstellung der einzelnen Materialebenen eines
Halbleiterchips

Layout Versus Schematic, Vergleich der Netzlisten von
Layout und Schaltplan

Integrierte Schaltkreise, die sowohl digitale als auch analoge
Funktionalitat beinhalten

Funktionelle Schaltungseinheit, wie z. B. ein Gatter, ein
Verstarker oder auch das komplette Design (Top-Level-
Modul)

Gatter, das Eingangssignale mit einem logischen UND
verknipft und dann negiert

Textuelle Beschreibung der Verknipfung von Bauelementen
bzw. Gattern mittels Netzen

Gatter, das Eingangssignale mit einem logischen ODER
verknUpft und dann negiert

AuRenanschluss des Schaltkreises
AuRerer Ring, auf dem Pads angeordnet werden
Verbindung der Auf3enanschlisse mit dem Kern (Core)

Symbol fiir Signalein- und -ausgange eines Moduls im
Schaltplan

Stromversorgungs-/ Masseflachen links und rechts vom Kern
Simulation Program with IC Emphasis, Simulationswerkzeug

Gatter, die zur besseren Reihenanordnung alle dieselbe
Hohe besitzen

Oberstes Modul in einer Design-Hierarchie

Tanner Place and Route Netzlistenformat — enthalt die
Beschreibung eines Designs in Textform und die
Verknupfungen mit den verwendeten Standardzellen

Durchkontaktierung zwischen Metallebenen
Stromversorgung der Standardzellen

Gatter, eXclusive OR, exklusives Oder — Ausgang ist genau
dann logisch ,1“ ist, wenn an einer ungeraden Anzahl von
Eingangen ,1“ anliegt und an den restlichen ,,0*
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